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FORTIS™ 2.4 RELEASE NOTES

RELEASE HISTORY

RELEASE 2.4.1 (09/2008)

Fortis 2.4.1 resolves numerous open issues and includes several new features and product
enhancements. It is recommended that all customers upgrade to Fortis 2.4.1 to take advantage
of the improvements.

NOTE: Fortis 2.4.1 includes all hot fixes and service pack updates released for Fortis 2.4.0.
Customers can upgrade to Fortis 2.4.1 directly from Fortis 2.3.0 or 2.4.0 and the installation will
be upgraded to include all of the previous updates. Installation instructions can be found in the
Fortis Installation Guide.pdf document included with the release or available for download from
our website.

» AutoCAD: eDrawings Integration — Westbrook Technologies has partnered with
SolidWorks Corporation to provide our customers with enhanced support of various
AutoCAD file formats through integration with the SolidWorks eDrawings Viewer. The
updated list of supported file formats includes:

v' DWG / DXF all versions up to 2008
v' eDrawings (eDRW, ePRT, eASM)

v Native SolidWorks Documents (sldprt, sldasm, slddrw)

Important: Customers who wish to use the eDrawings integration to access updated AutoCAD
support need to download eDrawings from the SolidWorks website and install it on each of the
Fortis Workstations. The eDrawings installer will prompt you to enter a license key, skip this
screen and proceed with the remainder of the install and registration.

Click the following link for information about eDrawings and to download the viewer:
eDrawings AutoCAD viewer.
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» Export: PDF/A-1b — We are pleased to announce that customers now have the option to
export documents as PDF using a PDF/A-1b compliant format. PDF/A-1b is a standard
that defines a format to be used for long term archival storage of electronic documents.
More information on PDF/A can be found here: http://en.wikipedia.org/wiki/PDF/A

» CDExpress — Based on popular demand from our customers, we have reinstated
CDExpress as a supported option in Fortis 2.4.1. CDExpress now also uses Microsoft SQL
Server 2005 Express instead of MSDE.

NOTE: Customers that plan to use Windows Vista to create a CDExpress “recording” should
launch the Fortis Database Administration station as a Windows user that has administrative
privileges and using the “Run as administrator” Windows command.

» Fortis eCopy ShareScan OP — Fortis 2.4.1 now supports eCopy ShareScan OP 4.2
including support for the Ricoh MFPs that were added by eCopy in their SSOP 4.2
release.

» Fortis Ascent: Enhancement — We have made several miscellaneous performance
improvements to our Fortis Ascent release script built for Kofax Ascent Capture 7.5 and
the newly released Kofax Capture 8.0. In particular customers using Oracle 10g should
notice a significant increase in import speed as compared to previous versions of Fortis
Ascent. (9473)

NOTE: Oracle 10g customers should use the Oracle 10g Client Driver (10.2.0.4). Our testing
indicates this driver provides optimal performance of Kofax Capture.

» Fortis Ascent: Kofax Capture 8.0 — Fortis Ascent is now certified for use with Kofax
Capture 8.0.

» Authentication: User Logon Performance - We have enhanced the mechanism that
Fortis uses to authenticate and login users. In particular customers with a very large
number of users should see faster logins to the Fortis client.

» Install: Silent Workstation Preferences — A new “preferences generator” utility has been
added in Fortis 2.4.1 to allow a Fortis Administrator to configure Fortis Workstations
preferences and then save them to an INI file. The Fortis Admin can then use the newly
created preferences.ini file to push the specified user preferences down to other
workstations using the Fortis Workstation MSI to perform a “push” or “silent” install.
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>

Printing: Inverse Print — Resolved an issue with certain wide format printers and their
related drivers where documents printed via Fortis may appear inverted (white on black
instead of black on white). The resolution was to add a new printing preference, “Inverse
Print Override” that can be set on each individual printer connected to a workstation.
(9548)

NOTE: The “Inverse Print Override” preference is only supported on Black & White printers.

Using this setting with color printers is not supported and the output will produce poor results.

This new preference setting is only supported in the core Fortis application. Add on modules

and professional services products such as Fortis QuickFind that do not support user

preferences will not be able to use the new setting.

>

Printing: Query Results — Resolved an issue that would cause an Access Violation in
module mfc42.dll when a user attempted to print the data from the query results.
(9469)

Print Documents: Query Result - Resolved an issue with printing documents by selecting
them from a query result. When a user selected multiple documents, only the first
document selected was being printed. Fortis now prints all the selected documents.
(9483)

Fortis Oracle — Resolved an issue with Fortis for Oracle where it would generate an error
in FMP.EXE “FMP.EXE Application Error Message-The instruction at "0x77f536f7"
referenced memory at "Oxffffffff". The memory could not be read. Click on Ok to
terminate the program.” The issue was escalated to Oracle as an ODBC driver defect,
the issue has been confirmed fixed using Oracle 10g Client Driver version (10.2.0.4)

Data Entry Assistant: File DSN — We have corrected an issue that prevented users of
Data Entry Assistant from using an ODBC data source that is specified in a File DSN.
(9196)

Print to MAG: Paper Size Selection — Corrected the inadvertent exclusion of the A3
paper size from the dialog in the new Print to MAG driver created for the 2.4.0 release.
(9258)

Auto Logoff: LDAP — Resolved an issue that prevented LDAP users from using Fortis after
Auto Logoff timed out their session. (9261)

Annotations: OLE Object — Resolved an issue that prevented users from adding an
existing object as an OLE Annotation to a Fortis document. (9272)
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» Annotations: Searchable — Resolved an issue where document types that contained a
field with the unique attribute enabled would cause the Enable Search Annotations
checkbox to clear. (9512)

» Related Document: Annotations — Resolved an issue with annotations where under
certain conditions they became invisible. For example, when a user modified an existing
related document link on the same page that display the annotations. (9424)

» Fortis Web: Security — Fixed a potential vulnerability to client side scripting being
inserted into user-supplied variables. The attack surface was extremely limited in that
the injected scripting still required a valid Fortis username/password to execute. The fix
will now prevent any client side scripting inserted into a user variable from executing,
even in the event that a valid Fortis username and password are provided. (9731)

» Fortis Web: Query Results — Resolved an issue where documents opened and modified
from a query result would continue to be included in the query results after running the
same query again even though the document index data had been modified and no
longer satisfied the query criteria. (9776)

» Fortis Web: Query Data Validation — Enhanced validation on data being entered into a
guery prompt via Fortis Web. Fortis Web now enforces the minimum character length
be entered on a prompt the same way that the Fortis LAN client does. Prior to this
change Fortis Web would accept less than the minimum number of characters and
attempt to run the query. (9455)

» Pick Lists: Inserting Values — Resolved an issue where inserting a value into a pick list
would add an extra row that contains a duplicate of the value above the row being
inserted. (9563)

» Email Attachments: PDF — Resolved an issue where PDF documents, imported as email
attachments, are set in user preferences to use Acrobat Reader, but would instead open
in the Fortis Document Viewer. (9412)

» Format Masks: Dates — Updated the requirements for date format masks, they must
include a minimum of month and year as part of the format mask. SQL databases do
not have the concept of a “year only” date field. In some cases customers were
attempting to create a format mask such as YYYY and doing so would generate a SQL
error message “date out of range”. Customers who require a field that displays only the
year should use an integer field or a character field with a format mask #### to enforce
entry of a four digit year. (9438)

Westbrook Technologies, Inc. - 22 Summit Place - Branford, CT 06405 USA

Toll free: 800-949-3453 | Outside U.S.: (+1) 203-483-6666 | Fax: 203-483-3350
e-mail: Info@westbrooktech.com



Fortis Release Notes Page |5

» Import Documents: Full Text — Corrected an issue that would cause the full text
information dialog box to turn blank during the import of a large batch of documents to
a full text document type. (9467)

» Preferences: View — Resolved an issue where using the View > Document & Index Data >
Swap menu option to swap the document viewer and index data controls was not being
saved after the user closed the window. (9474)

» Queries: Multi-Value Fields — Corrected an error that would result if a user attempted to
modify index data in a query result that contained a multi-value field. (9445)

» Queries: Versioned Documents — Resolved an issue where users running a browse query
with multiple fields against a versioned document type would return an error
“Ambiguous column name ‘date’. The cursor was not declared.” (9478)

» Queries: Date/Time — Resolved an issue with range queries of formatted date/time
fields that would result in the error “Syntax error converting date/time from character
string. The cursor was not declared.” (9454)

» Query: “Is Empty” w/ Text Fields —Resolved an issue with queries that apply the “Is
Empty” search operator to a field of data type Text. (8409)

» Query: Full Text — Added a new Full Text Query preference to specify a limit on the
number of full text indexed pages to return. If no value is set the default limit is 2500
Full Text indexed pages. (9580)

» Fortis Office: Default Location — Resolved an issue where installing the Fortis
Workstation would cause MS Office applications such as Excel, Word & Outlook to
default to looking at the Fortis directory when using the File > Open menu in the various
MS Office applications. (9481)

» Fortis Office: Error — Resolved an issue where installing legacy versions of certain
LEADTOOLS applications would cause Fortis Office to fail on startup with the error
“Automation error a dynamic link library (DLL) initialization routine failed.” (9564)

» DDE: LinkRequest Failure — Resolved an issue that would cause a DDE LinkRequest to fail
on a field that contained more than 1023 characters. (9560)

» Document Types: Unique Fields — Resolved an issue where under certain conditions
using versioned document types, the unique field attribute would be enabled in cases
that it should not have been. (8425)
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» AutoCAD: DWG — Resolved an issue with the Fortis Document Viewer that would result
in a crash if the user attempted to open 3 or more DWG files at the same time. (9194)

» Export DB: Append — Resolved a Ul issue that resulted in a message box with truncated
text being displayed during append of an exported database that contains duplicate
document type names. (8485)

» OCR: Template Button — Resolved a Ul issue that would make it appear that the user
was drawing an annotation when they had actually had selected the toolbar button to
create an OCR Template Zone. (8262)

» OCR: Adobe Image on Text — Resolved an issue that resulted in a blank page being
displayed instead of the OCR Results when the OCR text format selected was Adobe
Image on Text. NOTE: We recommended that customers install Acrobat Reader and use
the Fortis preference to view PDF in Acrobat for optimal viewing results. (9430)

» OCR: Results Location — Resolved an issue with user selected OCR Results location
(Before Each Page, After Each Page, At End of the Document, etc) not being retained
from one document to the next. (9452)

» Installation: All Users — Corrected the option to install Fortis for All Users or the Current
User not being consistently presented. (9443)

» Installation: Print to MAG — Resolved an issue during a workstation upgrade that would
sometimes cause the recreation of a new MAG1 printer port to fail during the update of
the Print to MAG driver. (9598)

» Uninstall: FCOMAPI.DLL — Resolved an issue that prevented the FCOMAPI.DLL from
being unregistered manually or during uninstall of Fortis. (9458)

» Installation: Product Registration — Resolved an issue that prevented customers from
using the product registration feature during the Fortis install. (9447)

» Installation: Requirements — Reworded a dialog that contained redundant text “requires
the following requirements” now reads “requires the following pre-requisites”. (9448)

» Document Viewer: MS Excel Files — Resolved an issue where an error message would
appear in the Fortis document viewer “Error: Unknown error“when a user attempted to
open certain types of MS Excel files. (9761)
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» Document Viewer — Resolved an issue that was causing an Access Violation in FMP.EXE
when multiple users attempt to open and view the same document from a Fortis In
Basket. (9475)

» LDAP: Configuration Dialog — Resized the dialog box to resolve an issue with some of the
text being truncated. (9450)

» Toolbar Buttons: OCR Document / Page — Resolved an issue that was causing the OCR
Document and OCR Page toolbar buttons to be disabled in certain cases where they
should have been enabled. (9451)

» Toolbar Buttons: Launch & Burst — Resolved an issue that would intermittently cause the
Launch and Burst buttons to be disabled in cases where they should have been enabled.
(9437)

» Menus: Related Documents - Resolved an issue that would cause the Related
Documents menu items to be disabled after clicking on a Related Document Link or
running a Fortis Query. This would sometimes also disable the Templates menu. (9423)

» Fortis Keyboard Shortcuts: Acrobat Reader - We have added the TAB key to a number of
Fortis keyboard shortcuts to resolve a problem where Fortis and Acrobat Reader were
using the exact same keyboard shortcut combinations and users would be making
control inputs to Acrobat Reader when they were attempting to control Fortis. A
complete list of Fortis keyboard shortcuts is available in the Fortis Help system. (9354)

» Export to PDF - Resolved an issue with exporting color documents to PDF. Sometimes an
error message was displayed instead of the document being exported. (9562)

» Export: Convert Pages — Resolved an issue with exporting a color image, using the
convert pages option. It resulted in the pages being exported as a mirror image. (8824)

» COM: Export/Print — Corrected several miscellaneous issues that would cause a dialog
box to open on the PC running the COM application in situations where a dialog box was
not desired. Errors will now be written to a file in the SYSDATA\COMLOGS directory.
(9487)

» Email Document: PDF — Resolved an issue where sending a Fortis document as an email
attachment in PDF format would not include annotations as expected. (9482)
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RELEASE 2.4.0 SERVICE PACK 2 (04/2008)

Fortis 2.4.0 Service Pack 2 contains a number of enhancements and problem fixes to the Fortis
Workstation MSI Installer. It is recommended that all customers install Service Pack 2 on top of
their existing Fortis 2.4.0 installation and run a workstation setup on all Fortis Workstations.

Important: Inflo customers must install Hot Fix 2 (HF2) before upgrading to 2.4.0 Service
Pack 2. If you have already upgraded to Service Pack 2 then please run the Hot Fix 2
install and then run the Service Pack 2 install again.

» Silent Workstation Setup — A new section has been added to the Fortis Installation
Guide to provide documentation on how to use the Fortis Workstation MSI to do a
“silent” or “push” installation. It includes a full list of MSI public properties that can be
set.

» Fortis Office: Uninstall - Improvements have been made to the routines that handle
removing the “Send to Fortis” buttons from the various Microsoft Office applications. A
few scenarios beyond our control remain where the removal of these buttons may fail.
The Fortis Installation Guide has been updated to include information on how to
manually remove the “Send to Fortis” buttons.

» Installation — Fixed a problem with the Windows installer log window preventing the
workstation install from completing. (9312, 9479)

» Uninstall — Choosing Uninstall on Fortis Workstation in the Control Panel Add/Remove
Programs, now performs a complete uninstall. (9440)

» Installation: Print To MAG — Users will no longer be prompted with a Windows Logo
Warning dialog during the installation of the Print To MAG driver. (9472)

» Installation: QuickFind — A problem on startup of QuickFind has been addressed. The
problem was causing an error “Component 'MSCOMCTL.OCX' or one of its dependencies
not correctly registered: a file is missing or invalid”. (9492)

» Installation: Fortis Web ActiveX — Fixed a problem that would cause the error message
“Unable to load import library” to appear when attempting to import a document via
Fortis Web. (9500)
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RELEASE 2.4.0 HF2 (03/2008)

Fortis 2.4.0 HF2 contains several enhancements to the product related to providing the ability
to append values to a multi-value field. These enhancements are provided in the following
product feature functions listed below.

Important: Inflo customers must install Hot Fix 2 (HF2) before upgrading to 2.4.0 Service
Pack 2. If you have already upgraded to Service Pack 2 then please run the Hot Fix 2
install and then run the Service Pack 2 install again.

» Inflo: Action — A new Inflo rule query action called “Append Multi-Value Field” has been
added. The “Append Multi-Value Field” action will enable the user to select from the list
of multi-value fields included in the rule query layout. The user will also be able to set
the values that will be appended to the existing data for that field.

» Import Data and Documents: Update Existing Documents - A new checkbox has been
added to the Import Data and Documents dialog on the Advanced tab called “Append to
multi-value fields”. If a user selects “Update existing documents” on the Documents tab
they will have the option to append the data contained in the data file to the existing
multi-value field data.

» COM API: Append Data - A new method called “AppendToMultiValueField” has been
added to the Field object in the COM API to support appending data to multi-value
fields. This new function takes the same argument as the previous set property for
ValuesOnMultiValueField.

» Auto Number: Modify Data — Resolved an issue that was causing errors when a user
attempts to save modifications made to index data in a query result window. The issue
was specific to query results that include document types with auto numbering enabled.
(9420)
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RELEASE 2.4.0 SERVICE PACK 1 (02/2008)

Fortis 2.4.0 Service Pack 1 contains a significant number of problem fixes and miscellaneous

performance improvements. It is recommended that all customers install Service Pack 1 on top

of their existing Fortis 2.4.0 installation. Installation instructions for 2.4.0 Service Pack 1 can be

found in the Fortis Installation Guide.pdf document included with the Service Pack or available

for download from our website.

>

Inflo: Server — Corrected several memory handling issues that would intermittently
cause the Inflo Server to crash or stop responding. The most common scenario where
this crash would occur is during repetitive execution of Inflo actions such as Send Mail or
Move to Folder. (9449)

Inflo: Add Database — Corrected a text label that mistakenly displayed as PowerWeb
instead of Fortis Web. (9425)

Index Data: Modify — Resolved several issues that would prevent a user from modifying
index data records on document types that contain very complex data structures such
as multiple 8000 byte text fields, multiple multi-value fields and multiple pick list fields
all within the same document type. (9407)

Document Types: Modify - Resolved an issue that prevented an administrator from
modifying document types that contain very complex data structures such as multiple
8000 byte text fields, multiple multi-value fields and multiple pick list fields all within the
same document type. Known error symptoms include: Invalid date format, Invalid time
format, Invalid pick list item, Memory access error or possibly a GPF during the attempt
to modify the document type. (9453)

Document Types: Modify - Added a dialog box to warn Administrators that certain
document type changes such as add/removing fields or changing the order of fields
require them to update all objects such as Queries, OCR templates, etc. that are related
to the modified document type. (9208)

COM: FComlsFeatureAvailable and FComIsDBFeatureAvailable — Resolved an issue with
these COM API methods would return a value of False even in cases where it should
have returned a value of True. (9177)
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» Import: Performance — Resolved an issue where indexing multiple documents of the
same document type thru the COM APl would take a significant amount of time per
document. Customers may also notice an increase in performance when manually
indexing multiple documents of the same type from an in basket using the Fortis client.
(51560)

» OCR: Point & Shoot — Added support to allow multiple OCR zones to map to a single
multi-value field and select either append or replace data in the field. (9401)

» OCR: Point & Shoot — Resolved an issue that prevented an OCR zone from populating a
date field that uses the format dd/mm/yyyy. (9403)

» OCR: Point & Shoot — Resolved an issue that would result in the incorrect century being
entered using an OCR zone to populate a date field if the data contained a two-digit
year. OCR will now use Windows Regional Settings to determine the century if it is not
entered. (8000)

» OCR: Point & Shoot — Resolved an issue with creating OCR zones that extended beyond
the boundary of the page would populate the target index field with invalid data. (8780)

» OCR: Point & Shoot — Resolved an issue where an OCR zone read that did not pickup any
data would populate the target index field with data from another OCR Zone in the
template. (9433)

» OCR: Templates — Resolved several issues that would intermittently result in a GPF error
while attempting to use an OCR Template. (9444, 9429)

» BCR: Templates — Resolved an issue where using a BCR template to import and index
documents was improperly setting the “hidden” file attribute on documents that failed
to import. (8391)

» Export Document: PDF — Resolved an issue where exporting a Fortis Document
containing only a single PDF file would fail to export the PDF file. (9422)

» Fortis Web: ActiveX — Resolved an intermittent issue with updating the Windows
Registry during install where the ActiveX control would sometimes report an error
“Installation not found” after the ActiveX control install had previously reported that it
had completed successfully. (9421)
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» Fortis Web: ActiveX — Resolved an issue where in some cases upgrading the Fortis Web
ActiveX control on a workstation would result in some of the preference settings being
reset. (9426)

» Fortis Web: Outlook Public Folder - It is now possible to point a public folder in Outlook
2007 at a Fortis Web page. (8475)

» Fortis Web: Updating Large Documents — resolved an issue where updating a large
document containing 500 pages would sometimes return the user to the Fortis Web
login page. (9385)

» Fortis Web: Annotations — Resolved an issue with Fortis ERM documents not properly
updating thru the Fortis Web client when a user deleted an annotation. (9362)

» Fortis Web: Email Documents — Corrected a text label error that incorrectly referred to
“PowerWeb Hyperlink” it now reads “Fortis Web Hyperlink” (9434)

> Fortis Web: Email Documents — Corrected a text label error on email attachments from
PW~ to FW~ (9379)

» Print Documents — Resolved an issue where in very isolated document specific cases a
Fortis Document would fail to print and CPU Utilization would get stuck at 99%. (8254)

» Export to PDF — Resolved an issue with very large text files failing to export as PDF in
these cases the CPU Utilization would get stuck at 99% and the export would not
complete. (8789)

» Query Results: Modify Data — Resolved an issue where modifying index data in the query
results grid and adding spaces to an empty field will result in null characters being
stored in the database. The most obvious side effect of the problem was queries on the
modified field for “Is Empty” will no longer return results for the modified record. (9343)

» Query Results: Close — Resolved an issue where a user would incorrectly get an error
“Query Results are in use and cannot be closed” when attempting to close the query
results window. This would typically happen if the user had just closed a document
previously opened from the query results and then immediately attempted to close the
query result window. (8450)

» Queries: Multiple Query Execution — Resolved an issue when documents of the same
document type are returned at the same time by two different queries with different
layouts, index data is displayed in the wrong fields. (7979)
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» AutoNumber: Set Matter Field — Improved error messaging in a situation where a user
attempts to add an AutoNumber and does not have permissions to set the data for the
Matter field which is a required field. The previous message was “Unknown Database
Error” the message now is “Invalid Matter Name”. (7716)

» Scan: Barcode contains Script — Resolved an issue where scanning documents with the
“Barcode Contains Script” option enabled would not prompt the user to add pages to
the scanner when the document feeder is empty. (9215)

» Scan: Barcode contains Script — Resolved an issue where scanning documents with the
“Barcode Contains Script” option enabled would sometimes result in duplicate pages
being added to the document. (9198)

» Scan: Document Description — A change was made to how the document description is
set such that if the user explicitly sets a document description it will no longer
automatically append #n to the description. If the user leaves document description
empty it will continue to automatically add the text “Scanned Document #n” (9341)

» Installer: ReadMe — Corrected an issue found in HF1 where the install would prompt the
user if they wanted to view the ReadMe and the wrong file would be displayed. Now if
the user selects yes the install will display the proper document Fortis Release
Notes.PDF. If the computer being used to run the service pack installer does not have a
copy of Acrobat Reader the install will prompt the user and ask if they would like to
install Acrobat Reader. (9417)

» Versioning: Enhance Document — Made a change to prevent a scenario where a user
could run a query and run image enhancements on a document and save changes
without checking out the document or creating a new version of the document. (9389)

» Versioning: Unique Fields — Resolved an issue where certain modifications in the
document type manager in Database Administration would allow the Unique attribute
to be enabled on fields where it was not appropriate to do so. (9378)

» Search Annotations: Setup — Resolved an issue where the cancel button would not
properly cancel a Search Annotation setup in progress. (9384)

» Fortis Office: Sentry — Resolved an issue when upgrading to Fortis 2.4 and running
workstation setup in some cases the Fortis Sentry buttons were not being removed
properly. (9382)
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» License Borrowing — Resolved an issue that prevented license borrowing from working
automatically as expected. (9175)

» Feature Access: Annotations - A new feature access permission called “Annotations:
Force on Output” has been added to allow Administrators to take away a user’s ability
to exclude annotations on output methods such as export and print. (9141)

» Import: Delete Temp Files — A new feature has been added to Import that allows the
user to delete any temporary files created during a failed import process. (9090)

» Script Manager: Execute Script - Resolved an issue where executing scripts using Script
Manager would sometimes generate duplicate messages. (9413)

» Fortis Office: Paste in Outlook — Resolved an issue where doing a paste into an MS
Outlook message (without having first chosen something to copy) would result in a
Fortis Icon being pasted into the message. (9275)

» Programmer’s Reference Guide — Fortis 2.4 SP 1 includes an updated version of the
Programmer’s Reference Guide that contains minor updates and rebuilt bookmarks.
(9406)

» Service Pack 1 includes all fixes from HF1 (Listed Below). If you have not already
installed HF1 then installing SP 1 is sufficient as it includes all the HF1 fixes as well.

RELEASE 2.4.0 HF1 (12/2007)

IMPORTANT: All Fortis 2.4.0 Customers — Fortis 2.4.0 HF1 is a hot fix update to the Fortis 2.4.0
release done to fix several critical issues. Customers who have already upgraded to Fortis
2.4.0 who suspect that they may have experienced any of these issues should carefully track
any documents that have been added to Fortis since they upgraded to Fortis 2.4.0 and verify
that the documents were captured properly. In some cases documents may need to be
reprocessed to correct any issues that may have occurred during capture. Please note that
only documents captured using one of the three methods below are subject to review, there
is no cause for any concern regarding any other Fortis capture methods.
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Critical Issues:

» Fortis Office: Send To Fortis — Using Fortis Office to send a document directly into a
Fortis Database would report that the document was successfully captured but in some
cases the capture process did not actually execute correctly.

» Script Manager: Import Scripts — Using Script Manager to automatically execute import
scripts to capture and index documents directly into a Fortis Database would report that
the document was successfully captured but in some cases the capture process did not
actually execute correctly.

» Print To MAG: Using Print to MAG to capture a document set to print in landscape mode
would sometimes fail to capture the last page of the document into the target Fortis
Document file and no error message would occur.

Severe Issues:

» Fortis Office: Office 2007 — A defect in Microsoft Office 2007 Add-In support will in
certain cases prevent the Fortis Office Add-In from functioning correctly. A fix was put in
to provide Office 2007 with the direct path to the Fortis Office Add-In files so that they
are able to load and execute correctly.

NOTE: Customers who wish to apply Fortis 2.4.0 HF1 can download it from our website:
http://www.westbrooktech.com/Downloads/Fortis-2.4.0-HotFix1.exe

Instructions for applying Fortis 2.4.0 HF1 are located in Fortis Installation Guide.pdf also
available for download online.
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RELEASE 2.4.0 (12/2007)

>

We are pleased to announce the launching of Fortis Web, our new browser-based
document management solution. Fortis Web delivers easy access to the Fortis
repository from remote offices (or anywhere) so that your organization can manage
business critical information from the web. Existing PowerWeb customers will receive
the new Fortis Web solution as part of their Fortis 2.4 upgrade.

Fortis Web: Large Pick List Support — A new pick list control has been added to Fortis
Web that provides enhanced support for large pick lists. A paging control and advanced
search capabilities have been added to make it easier than ever for users to find and
select values from a pick list in Fortis Web.

Fortis Web: Email Support - Users can now email Fortis documents directly from the
Web Edit and View Station browser clients.

Fortis Web: Launch Document — Users can now launch Fortis documents using an
external application directly from the Web Edit and View Station browser clients.

Fortis Web: In Basket Support — Users can now access Fortis In Baskets via the Web Edit
Station browser client. Supported features include; view/print/export/delete
documents in an In Basket, importing documents into an In Basket and indexing
documents into a database from an In Basket.

Fortis Web: Change Passwords — Users now have the ability to change the password on
their Fortis login directly from a Web browser client.

Windows Vista Certification - Windows Vista has now been certified for use as a client
OS for Fortis. Supported versions of Windows Vista include Ultimate, Enterprise and
Business editions.
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» SQL Server 2005 Embedded and Express Editions — Fortis SE now ships with cutting edge
database platform support, Microsoft SQL Server 2005 Express. Fortis Demonstration
Version also now uses SQL Server 2005 Express. Fortis Embedded SQL Server now ships
with Microsoft SQL Server 2005 Embedded.

» Microsoft Office 2007 Certification - Fortis Office is now certified for use with Microsoft
Office 2007 including Outlook, Word, Excel and PowerPoint.

» Send To Fortis shortcut now installed on the desktop for all Fortis Office customers. You
can now import documents into Fortis by dragging and dropping them on to the Send To
Fortis shortcut.

» Searchable Annotations — Fortis Administrators can now enable searching of
annotations on Fortis Document Types. Users will be able to search for specific text
within an annotation as well as find annotations by type, i.e. FREEHAND, HIGHLIGHT,
LINE, NOTE, OLE, REDACTION and STAMP.

> Fortis LDAP — A new user interface and a new authentication mode called Mixed Mode
has been added to Fortis LDAP so that users now have three choices for user
authentication.

»  Fortis Authentication — Users are authenticated using only their Fortis username
and password.

%+ LDAP Authentication — Users are authenticated using only their LDAP username

and password

X/
°

Mixed Mode — Users are authenticated using either their Fortis or LDAP
username and password.

» SYSADM User Default Password Change - The Fortis SYSADM user default password has
been changed for all new installs of Fortis 2.4.0. The new default SYSADM password is
now: westtech#1

The SYSADM user password will NOT be changed on existing Fortis installations that
upgrade to Fortis 2.4.0. It is STRONGLY RECOMMENDED that all Fortis customers
change the SYSADM user password to something unique immediately after installation
of Fortis 2.4.0 to make the SYSADM login more secure.

Westbrook Technologies, Inc. - 22 Summit Place - Branford, CT 06405 USA
Toll free: 800-949-3453 | Outside U.S.: (+1) 203-483-6666 | Fax: 203-483-3350
e-mail: Info@westbrooktech.com



Fortis Release Notes Page | 18

» Fortis Inflo: Run as Windows Service — Inflo, the workflow answer now runs as a
Windows Service providing improved fault tolerance and reliability.

» Fortis Script Manager: Run as Windows Service — Script Manager automates the
execution of capture scripts in Fortis. It now runs as a Windows Service providing
improved fault tolerance and reliability.

» Enhanced COM API Support — New commands added include; Print, Create/Delete
Folder, Export to TIFF and Export to PDF.

» Updated look-and-feel for the user interface- The interface for Fortis 2.4 has been
enhanced to provide a more modern look while retaining the usability customers have
come to depend on.

» MSlI Installers for improved performance and reliability. Customers should now be able
to take advantage of MSI technology to create automated deployments of Fortis
workstations.

» Enhanced OCR functionality — A number of miscellaneous improvements have been
made to OCR including support for Windows Vista.

» Enhanced PDF Export — Export to PDF now includes improved support for color
documents and support for Windows Vista.

» Updated Scanner Technology Support — A number of miscellaneous improvements have
been made to scanning including the ability to support newer model scanners and
support for scanning under Windows Vista has been added.

» Color Documents — miscellaneous improvements have been made to the support of
color documents including new options for file compression to control image quality vs.
file size.
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» Discontinued Support — We will no longer be providing technical support for the
following software and platforms with this release.

v' CDExpress is no longer supported as of release 2.4 customers will no longer be
able to create CDExpress databases.

v’ Fortis Office Sentry is no longer supported as of release 2.4. All existing Fortis
Office Sentry customers will be upgraded to the new Fortis Office module.

v Fortis Web — Now requires Windows Server 2003 with 1IS 6.0. Windows 2000
Server with 1IS 5.0 is no longer supported.

v All Oracle 8 versions are no longer supported. Oracle 9i and Oracle 10g are the
currently supported Oracle database platforms.

v" Microsoft SQL Server 7.0 is no longer supported. Microsoft SQL Server 2000 and
2005 are the currently supported platforms for Microsoft SQL Server.
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